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Safety Instructions • English

WARNING: This symbol, , when used on the product, is intended to 
alert the user of the presence of uninsulated dangerous voltage within 
the product’s enclosure that may present a risk of electric shock.

ATTENTION: This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron 
website, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT: Ce pictogramme, , lorsqu’il est utilisé sur 
le produit, signale à l’utilisateur la présence à l’intérieur du boîtier 
du produit d’une tension électrique dangereuse susceptible de 
provoquer un choc électrique.

ATTENTION:  Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la 
réglementation, la compatibilité EMI/EMF, l’accessibilité, et autres sujets 
connexes, lisez les informations de sécurité et de conformité Extron, réf.  
68-290-01, sur le site Extron, www.extron.fr.

Sicherheitsanweisungen • Deutsch

WARNUNG: Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind 
und die einen elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in 
der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.de.

Instrucciones de seguridad • Español

ADVERTENCIA: Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:  Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con 
el equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad 
de Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.es.

Chinese Simplified（简体中文）

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 

电压，有触电危险。

注意： 产品 上 的 这个标 志意在 提 示用户设备 随 附的用户手 册 中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 

使用的特性等相关内容，敬请访问 Extron 网站 www.extron.cn，参见 Extron  
安全规范指南，产品编号 68-290-01。

Chinese Traditional（繁體中文）

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 

可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細
資訊，請瀏覽 Extron 網站：www.extron.cn，然後參閱《Extron 安全性與法規
遵守手冊》，準則編號 68-290-01。

Japanese

警告:	この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
  いない高電圧が流れ、感電の危険があることを示しています。

注意:	この記号  が製品上に表示されている場合は、本機の取扱説明書に 
記載されている重要な操作と保守(整備)の指示についてユーザーの

	 注意を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイトwww.extron.jpより 

『Extron Safety and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。

Korean

경고:    이 기호 , 가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:     이 기호 , 가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 
항목에 대한 자세한 내용은 Extron 웹 사이트(www.extron.co.kr)의 
Extron 안전 및 규제 준수 안내서, 68-290-01 조항을 참조하십시오. 

http://www.extron.fr
http://www.extron.de
http://www.extron.es
http://www.extron.cn
http://www.extron.cn
http://www.extron.jp/
http://www.extron.co.kr


FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC rules. The Class A limits provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause interference; the user must correct the interference at 
his own expense.

NOTE: For more information on safety guidelines, regulatory compliances, EMI/EMF compatibility, 
accessibility, and related topics, see the “Extron Safety and Regulatory Compliance 
Guide” on the Extron website.

FDA/IEC 60825-1 Requirements

CLASS 1 LASER PRODUCT

Complies with FDA performance standards for laser products except for deviations pursuant 
to Laser Notice No. 5, dated June 24, 2007.

The product is intended to be used with the fiber optic cables fully installed.

This product meets the applicable requirements of IEC 60825-1, Edition 1 (2007).

Any service to this product must be carried out by Extron Electronics and its qualified 
service personnel.

Copyright
© 2013  Extron Electronics. All rights reserved.
Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.
The following registered trademarks(®), registered service marks(SM), and trademarks(TM) are the property of  
RGB Systems, Inc. or Extron Electronics:

Registered Trademarks (®)

AVTrac, Cable Cubby, CrossPoint, eBUS, EDID Manager, EDID Minder, Extron, Flat Field, GlobalViewer, Hideaway, Inline, IP Intercom,  
IP Link, Key Minder, LockIt, MediaLink, PoleVault, PowerCage, PURE3, Quantum, SoundField, SpeedMount, SpeedSwitch, System Integrator, 
TouchLink, V-Lock, VersaTools, VN-Matrix,  VoiceLift, WallVault, WindoWall, XTP, XTP Systems

Registered Service Mark(SM) :  S3 Service Support Solutions

Trademarks (™)

AAP, AFL (Accu-Rate Frame Lock), ADSP (Advanced Digital Sync Processing), AIS (Advanced Instruction Set), Auto-Image, CDRS (Class D 
Ripple Suppression), DDSP (Digital Display Sync Processing), DMI (Dynamic Motion Interpolation), Driver Configurator, DSP Configurator, DSVP 
(Digital Sync Validation Processing), FastBite, FOXBOX, IP Intercom HelpDesk, MAAP, MicroDigital, ProDSP, QS-FPC (QuickSwitch Front Panel 
Controller), Scope-Trigger, SIS, Simple Instruction Set, Skew-Free, SpeedNav, TeamWork, Triple-Action Switching, XTRA, ZipCaddy, ZipClip

http://media.extron.com/download/files/userman/68-290-01_J.pdf
http://media.extron.com/download/files/userman/68-290-01_J.pdf


Conventions Used in this Guide

Notifications
The following notifications are used in this guide:

WARNING: A warning indicates a situation that has the potential to result in death or 
severe injury. 

CAUTION: A caution indicates a situation that may result in minor injury.

ATTENTION: Attention indicates a situation that may damage or destroy the product or 
associated equipment. 

NOTE: A note draws attention to important information.

TIP: A tip provides a suggestion to make working with the application easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X! *X1&* X2)* X2#* X2! CE}

NOTE: For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” represents the 
capital letter “o.”

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.

Click the OK button.

Specifications Availability
Product specification are available on the Extron website, www.extron.com.

www.extron.com
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Introduction

This section contains general information about this guide and the FOX T USW 103 
Universal Switcher with an integrated fiber optic transmitter, selected device features, and a 
typical application diagram. Topics in this section include:

•	 About This Guide

•	 About the FOX T USW 103

•	 Key Features

•	 Application Diagram

About This Guide
This guide describes installation, operation, and control procedures, and reference 
information for the FOX T USW 103 Universal Switcher with an integrated fiber optic 
transmitter. In this guide, the terms “FOX T USW 103” and “switcher” are used 
interchangeably to refer to the FOX T USW 103 Universal Switcher with an integrated fiber 
optic transmitter in singlemode or multimode.

About the FOX T USW 103
The Extron FOX T USW 103 is a three input universal switcher with an integrated fiber optic 
transmitter that provides long haul transmission of HDCP-compliant HDMI, RGBHV, or HD 
component video; stereo audio; and RS-232 signals over fiber optic cabling. The switcher  
delivers pixel-for-pixel transmission of images up to 1920x1200, including HDTV 1080p/60.

To configure and control the FOX T USW 103, connect a host device, such as a computer, 
and enter Simple Instruction Set (SIS) commands (see Simple Instruction Set Control 
on page 12) or use the FOX Extenders Control Program (see FOX Extenders Control 
Program on page 20).

System Compatibility
The FOX T USW 103 operates in either of two modes, selected under RS-232 control, for 
compatibility with other, non-HDMI, units:

•	 Plus — Supports resolutions up to 1920x1200 @ 60Hz. The fiber optic output of the 
switcher can be received only by one of six receivers: a FOXBOX HDMI Rx,  
FOXBOX DVI Plus Rx, PowerCage HDMI Rx, PowerCage FOX DVI Plus Rx,  
FOXBOX SR HDMI, and PowerCage FOX SR HDMI.

•	 Non-Plus — Supports resolutions up to 1600x1200 and 1080p @ 60 Hz (including 
HDTV 1080p/60 Hz), is HDCP compliant, and does not contain embedded audio 
(analog audio is still supported). The fiber optic output of the transmitter can be received 
by any FOXBOX, PowerCage FOX, and FOX 500 VGA and DVI unit, including the Plus 
and non-Plus units.

Cable Transmission Modes
The transmitter is further categorized by the type of fiber optic cable, multimode  
(FOX T USW 103 MM) or singlemode (FOX T USW 103 SM), which define the effective 
range of transmission:

•	 Multimode — Long distance, up to 2 km (6,560 feet) (depending on the fiber cable)

•	 Singlemode — Very long distance, up to 30 km (18.75 miles)

1FOX T USW 103 Universal Switcher • Introduction



Key Features
Long distance fiber optics transmission — Transmits HDMI or analog video, stereo 
audio, and RS-232 signals up to 30 km when using singlemode fiber optic cabling.

Inputs — Include two female HDMI type A connectors, one RGBHV/RGBS or HD 
component on 15-pin HD connector, and one unbalanced analog stereo audio on 3.5 mm 
stereo mini-jack.

All digital technology — Delivers pixel-for-pixel transmission of video signals to ensure 
optimal image quality at resolutions up to 1920x1200, including HDTV 1080p/60.

Digital conversion of analog video and audio input signals — Digitizes analog signals, 
ensuring that a reliable, high quality digital video signal is sent to the output destination.

Auto-input switching — Automatically switches to the highest or lowest priority input with 
an active video signal for simplified operation.

HDCP-compliance

Key Minder — Authenticates and maintains continuous HDCP encryption between input 
and output devices to ensure quick and reliable switching in professional AV environments, 
while enabling simultaneous distribution of a single source signal to one or more displays.

EDID Minder — Automatically manages EDID communication between connected devices 
to ensure that all sources properly power up and reliably display content.

Audio embedding — Converts analog stereo audio signals to digital HDMI audio when the 
analog input is selected.

Audio gain and attenuation adjustment capability

LED indicators for signal presence, HDCP, and power — Provides a visual indication of 
system status for real-time feedback and monitoring of key performance parameters.

RS-232 control — Features an RS-232 serial port for control and configuration.

Contact closure remote control availability

Alarm notification for fiber link loss — The FOX T USW 103 can be set up to trigger an 
external control system for immediate notification when a fiber link has been lost. Requires a 
second fiber link.

Multimode and singlemode availability — Available as an 850 nm multimode model for 
long-range transmissions up to 2 km (6,560 feet), and a 1310 nm singlemode model for 
extreme distances up to 30 km (18.75 miles).

Industry standard LC fiber optic connectors — Provide reliable physical connectivity 
and precise fiber core alignment.

Compatibility with the following Extron FOX series products:

•	 Matrix switchers — Creates HDCP-compliant signal distribution systems up to 
1000x1000 and larger.

•	 HDMI, DVI Plus, DVI, and VGA receivers — Compatible with FOX series HDMI,  
DVI Plus receivers up to 1920x1200, including HDTV 1080p/60. Compatible with  
FOX series DVI and VGA receivers up to 1600x1200, including HDTV 1080p/60.

NOTE: The FOX T USW 103 is not compatible with the FOX 3G HD-SDI, FOX 3G DVC, 
or FOX AV models.

Front panel USB configuration port

1 inch (2.5 cm) high, half rack width metal enclosure — Compact, low profile enclosure 
for discreet placement and concealment.

Includes LockIt HDMI cable lacing bracket

Energy-efficient external universal power supply included — Provides worldwide 
compatibility, low power consumption, and reduced operating costs.
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Application Diagram
The following diagram shows a typical application of the FOX T USW 103 with three input 
sources, a fiber optic receiver, and control system.
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Figure 1. Typical FOX T USW 103 Application
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Installation

This section describes information for connecting and wiring the FOX T USW 103. Topics in 
this section include:

•	 Mounting the FOX T USW 103

•	 Rear Panel Features

•	 Making Connections

Mounting the FOX T USW 103
The FOX T USW 103 can be mounted in a rack, under a desk, or on a tabletop (see 
Mounting on page 38 for more mounting details).

Rear Panel Features
FOX T USW 103

RS-232CONTACT
RS-232

OVER FIBER

AUDIOHDMIHDMIRGB/R-Y, Y, B-Y

ALARM

REMOTE

Tx Rx

Tx Rx

OPTICAL

INPUTS1POWER
12V
0.7 A MAX

2 3

LI
N

K

LI
N

K

G Tx Rx G1 2 1 2 3 G

a b c d e f gh

Figure 2. FOX T USW 103 Rear Panel Features

Input Connectors

a Analog video connector — Connect a video source to the female 15 HD connector, 
labeled input 1.

b HDMI connectors — Connect a source device to either or both HDMI connectors, 
labeled inputs 2 and 3 (see Connecting HDMI Connectors on page 6). They can 
accept HDMI, DVI, or dual mode DisplayPort video sources.

c Audio connector — Connect an analog audio source to the 3.5 mm TRS jack. All 
three video inputs can share this audio input.

Tip (+)

Sleeve (   )

Sleeve (   )

Ring (-)

Tip (+)

Audio Plugs.eps

RCA Connector

3.5 mm Stereo Plug Connector
(balanced)

Sleeve (   )

Ring (R)

Tip (L)

3.5 mm Stereo Plug Connector
(unbalanced)

Figure 3. Wiring for Unbalanced Stereo Audio
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The following table shows the audio format that is sent over the fiber connection when a 
specific audio format is not specified (see the Input audio selection SIS command on 
page 15 to switch the active audio source).

Selected Video 
Input

HDMI Embedded 
Audio Present

Analog Audio 
Present

Audio Sent Over Fiber

VGA N/A Yes Analog audio

VGA N/A No No audio

HDMI Yes No HDMI embedded audio

HDMI Yes Yes HDMI embedded audio

HDMI No Yes Analog audio

HDMI No No No audio

Fiber Optic Connector

d Fiber optic connector — For one-way video, audio, and serial communication from 
the FOX T USW 103 to a receiver, connect a fiber optic cable between the Tx port on 
the FOX T USW 103 and the Rx port on a receiver.

To return serial data from a receiver to the FOX T USW 103 or for HDCP-compliance, 
connect a fiber optic cable between the Rx port on the FOX T USW 103 and the Tx port 
on the receiver (see Wiring for Fiber Communication on page 7).

NOTES:  
• Ensure the proper fiber optic cable is used. Typically, singlemode fiber optic 

cable has a yellow jacket and multimode fiber optic cable has an orange or aqua 
jacket.

• Only one fiber optic cable, transmitter-Tx-to-receiver-Rx, is required for video, 
audio, serial command transmission, but the HDMI signal output on the receiver 
will not be HDCP-compliant and the FOX T USW 103 will not receive RS-232 
reports from the controlled device.

The Link LED indicators light when there is light presence on either fiber optic port.

RS-232 Over Fiber and Alarm Connector

e RS-232 Over Fiber port — To pass serial command signals to a receiver 
(for serial control of a projector, for example), connect a host device to 
the switcher via the leftmost poles (Tx, Rx, and G) of this 5-pole captive 
screw connector (see Wiring for RS-232 Over Fiber and Alarm 
Communication on page 8 for wiring configurations).

Alarm port —  For remote monitoring of the status of fiber optic link 2, 
connect a custom or furnished monitoring device to the switcher via the 
rightmost poles (1 and 2) of this 5-pole captive screw connector (see  
Wiring for RS-232 Over Fiber and Alarm Communication on page 8).

NOTE: Pins 1 and 2 short within the switcher when link 2 does not detect any 
connection.

ALARM

Tx Rx G 1    2

RS-232
OVER FIBER

ALARM

Tx Rx G 1    2

RS-232
OVER FIBER
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Control Connectors

f Contact closure connector — Connect a contact closure device (such as a simple 
switch) to the 3.5 mm, 4-pole captive screw connector. The first three ports are used for 
selecting inputs 1 through 3 when momentarily shorted to the ground pin (see Wiring 
for Remote Contact Closure Communication on page 8).

g RS-232 connector — Connect a host device to the 3.5 mm, 3-pole captive screw 
connector for serial control of the switcher.

Power Connector

h Power connector — Connect an external power supply to the 3.5 mm, 2-pole captive 
screw connector (see Wiring the Power Supply on page 9).

Making Connections

Connecting HDMI Connectors
Use an Extron LockIt Lacing Bracket to secure an HDMI cable to each device as follows:

3

3

1

2

4

5

Figure 4. Installing the LockIt Lacing Bracket

1. Plug the HDMI cable into the panel connector.

2. Loosen the HDMI connection mounting screw from the panel enough to allow the 
LockIt lacing bracket to be placed over it. The screw does not have to be removed.

3. Place the LockIt lacing bracket on the screw and against the HDMI connector, then 
tighten the screw to secure the bracket.

ATTENTION: Do not overtighten the HDMI connector mounting screw. The shield 
to which it is fastened to is very thin and can easily be stripped.

4. Loosely place the included tie wrap around the HDMI connector and the LockIt lacing 
bracket as shown.

5. While holding the connector securely against the lacing bracket, use pliers or a similar 
tool to tighten the tie wrap, then remove any excess length.
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Wiring for Fiber Communication

WARNING: Risk of serious physical injury. This device outputs 
continuous invisible light, which may be harmful to the eyes; use with 
caution. 

• Do not look into the rear panel fiber optic cable connectors or into 
the fiber optic cables themselves.

• Plug the attached dust caps into the optical transceivers when the 
fiber cable is unplugged.

NOTES: 
• Ensure the proper fiber optic cable is used for the  

FOX T USW 103 and receiver. Typically, singlemode fiber optic 
cable has a yellow jacket and multimode fiber optic cable has an 
orange or aqua jacket.

• Only one fiber optic cable, transmitter-Tx-to-reciever-Rx, is 
required for video, audio, and serial command transmission. 
However, for only one fiber optic cable:

• The HDMI signal output by the receiver is not HDCP compliant.

• RS-232 reports from a controlled device are not available.

• To receive responses from the controlled device and for  
HDCP-compliance, install both fiber optic cables.

Transmitter

to
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RxTx
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K
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RxTx
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Wiring for RS-232 Over Fiber and Alarm Communication
The RS-232 Over Fiber port is for transmission of serial signals, such as projector control 
signals. The alarm port is an internal relay to connect or disconnect a custom alarm circuit. 
Wire the connector as shown in figure 5 below.

RxTx

Alarm DeviceRS-232 Device
G

RS-232
OVER FIBER ALARM

Tx Rx G 1 2

1 2

Figure 5. Wiring the RS-232 Over Fiber and Alarm Connector

ATTENTION: The length of exposed wires is critical. The ideal length is  
3/16 inch (5 mm).

• Longer bare wires can short together.

• Shorter wires are not as secure in the connectors and could be pulled out.

For RS-232 over fiber connection, cross the Tx and Rx lines once between the source and 
the target.

The alarm pins do not produce any discrete on or off or voltage signals.

NOTES: 

• The alarm port does not produce any discrete on or off voltage signals.

• If power is lost or if link 2 optical light is disconnected, lost, or broken, alarm pins 1 
and 2 internally short.

Wiring for Remote Contact Closure Communication
Each port senses an external switch or contact closure. Use these ports to select an input 
on the switcher. Wire the connector as shown in figure 6 below.

CONTACT

1 2 3 G

Ground

Wire Nut

Device 3

Device 2

Device 1

(Switches, 
relays, or 

similar items)
Switch

1
2
3
G

Heat
Shrink
Over

Shield
Wires

Figure 6. Wiring the Contact Closure Connector
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Wiring the Power Supply
Connect a 12 VDC power supply to the 3.5 mm, 2-pole captive screw connector.

SECTION  A–A

AA

Power Supply
Output Cord

2-Pole Captive Screw
Connector

Ridges
Smooth

Tie Wrap

3/16”
(5 mm) Max.

Figure 7. Power Connector Wiring

CAUTION: Electric shock hazard. The two power cord wires must be kept separate 
while the power supply is plugged in. Remove power before wiring.

ATTENTION: 

• This product is intended to be supplied by a Listed Power Unit marked “Class 2” 
or “LPS,” rated 12 VDC, 1.0 A minimum. Always use a power supply supplied by 
or specified by Extron. Use of an unauthorized power supply voids all regulatory 
compliance certification and may cause damage to the supply and the end product.

• Unless otherwise stated, the AC/DC adapters are not suitable for use in air handling 
spaces or in wall cavities. The installation must always be in accordance with the 
applicable provisions of National Electrical Code ANSI/NFPA 70, article 75 and 
the Canadian Electrical Code part 1, section 16. The power supply shall not be 
permanently fixed to a building structure or similar structure.

• Power supply voltage polarity is critical. Incorrect voltage polarity can damage the 
power supply and the unit. The ridges on the side of the cord identify the power cord 
negative lead.

• The length of the exposed (stripped) copper wires is important. The ideal length is 
3/16 inch (5 mm).

TIP: Do not tin the stripped power supply leads. Tinned wires are not as secure in the 
captive screw connectors and could be pulled out.
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Operation

This section describes the front panel features of the FOX T USW 103 and describes front 
panel operations. Topics in this section include:

•	 Front Panel Features

•	 Front Panel Operation

Front Panel Features

FOX T USW 103

AUTO
SWITCH

MODE

CONFIG

NORMAL

1 2

AUTO

SIGNAL

HDCP

STATUS
3

1 2 3

a c db

Figure 8. FOX T USW 103 Front Panel Features

a Auto Switch LED — Lights when the transmitter is in auto switch mode.

b Config port — Connect a host device to the mini USB Config port for remote control.

c Input selection buttons —  Select inputs 1 through 3 or modes of operation. The 
corresponding LEDs light to indicate the active input.

d Status LEDs — The Signal LEDs light to indicate the signal presence of each input. 
The HDCP LEDs light when the signal on the corresponding input is HDCP compliant.  
Input 1 (the VGA connector) does not have an HDCP LED.

Front Panel Operation
 The three buttons with corresponding LEDs on the front panel (labeled Mode, Normal, and 
Auto) are used to manually select inputs 1 through 3 or enable and disable device modes. 
The LEDs indicate status and the currently selected input.

To enable or disable executive, auto switch, or normal switch mode from the front panel, 
press and hold a combination of input selection buttons simultaneously until the appropriate 
LEDs blink (see the table below for the different button combinations).

Front Panel Button Combinations for Device Modes

Mode Button Combinations

Executive 1, 2, and 3

Auto switch 
(prioritize the highest numbered active input)

1 and 3

Normal switch (default) 1 and 2

The front panel operations can also be performed remotely with SIS commands or the FOX 
Extenders Control Program (see Simple Instruction Set Control on page 12 or  
FOX Extenders Control Program on page 20).
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Initial Power Up
Upon initial power up, the front panel LEDs blink simultaneously. They blink once for 
multimode or twice for singlemode. Afterwards, the LEDs return to their normal signal 
presence indication.

If a different fiber optic SFP module or no SFP module is connected, the LEDs first blink 
once or twice to identify the device, but then blink continuously. 

Selecting an Input
To select an input from the front panel, perform the following actions:

1. Press the input selection button that corresponds with the desired rear panel input 
connector. 

2. The corresponding LED lights to indicate the active input.

Enabling or Disabling Front Panel Lockout Mode (Executive Mode)
Push and hold (for about 5 seconds) inputs 1, 2, and 3 simultaneously until the front 
panel LEDs blink three times to enable or disable front panel configuration. In executive 
mode, contact closure and RS-232 control are still available. By default, executive mode is 
disabled.

Enabling Auto Switch Mode
Press and hold (for about 3 seconds) inputs 1 and 3 simultaneously until the front panel 
Auto Switch LED lights. This prioritizes the highest numbered active input.

NOTE: Setting audio switch mode to prioritize the lowest numbered active input can be 
done only with SIS commands (see Auto switch mode SIS commands on page 15). 
Normal switch mode is the default mode.

Enabling Normal Switch Mode
Press and hold (for about 3 seconds) inputs 1 and 2 simultaneously until the front panel 
Auto Switch LED turns off. This is the default mode.
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SIS Configuration 
and Control

This section describes remote control of the FOX T USW 103 through SIS commands 
and basic installation instructions for the FOX Extenders Control Program (see to the FOX 
Extenders Control Program Help File for operation details).

To enable serial control of the FOX T USW 103, use a computer running the HyperTerminal 
or Extron DataViewer utility, or a control system. Connect the computer to the  
FOX T USW 103 through the front panel Config port or the rear panel RS-232 connector.

The protocol for the RS-232 port is as follows: 9600 baud, no parity, 8 data bits, 1 stop bit, 
no flow control

Simple Instruction Set Control

SIS Programming Guide

Host-to-device and device-to-host communication

SIS commands consist of one or more characters per field. No special characters are 
required to begin or end a command sequence. When the FOX T USW 103 determines that 
a command is valid, it executes the command and sends a response to the host device. 
All responses from the switcher or receiver to the host end with a carriage return and a line 
feed (CR/LF = ]), which signals the end of the response character string. A string is one or 
more characters.

Device-initiated messages

When a local event occurs, the device responds by sending a message to the host. The  
device-initiated message may depend on whether the device is multimode or singlemode. 
They are listed below.

© Copyright 2013, Extron Electronics FOX T USW 103 MM, Vx.xx, 60-1229-11

© Copyright 2013, Extron Electronics FOX T USW 103 SM, Vx.xx, 60-1229-12

Vx.xx is the firmware version number.

Reconfig] 
The FOX T USW 103 returns this message when there is any change to the input frequency 
on the currently selected input.

1LnkX%•2LnkX%•VidX%•AudX%•X1)•TX]
The FOX T USW 103 returns this status message whenever a change in the fiber link, video, 
or audio connection occurs. X% indicates whether the link is present or not present  
(0 = not present, 1 = present) and X1) represents whether the device is multimode or 
singlemode (MM = multimode, SM = singlemode).
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Error responses

When the FOX T USW 103 receives an SIS command and determines that it is valid, it 
performs the command and sends the corresponding response to the host device. If the 
command is determined invalid or contains invalid parameters, the switcher or receiver 
returns an error response to the host. The error response codes are:

E01 = Invalid input number E13 = Invalid parameter

E06 = Invalid switch attempt in this mode E14 = Not valid for this configuration

E10 = Invalid command E17 = Invalid command for signal type

E12 = Invalid port number E22 = Busy

Using the command and response table for SIS commands

The Command and Response Tables begin on page 15. Lowercase letters are 
acceptable in the command field except where indicated. Figure 9 shows the hexadecimal 
equivalent of ASCII characters used in the command and response tables.

ASCII to Hex Conversion Table

•

Space

Figure 9. ASCII to Hexadecimal Conversion

Symbol definitions

] = Carriage return and line feed

¦ or } = Carriage return with no line feed

• = Space

E or W = Escape key

 

FOX T USW 103 Universal Switcher • Remote Control 13



X2^ = EDID output resolution and refresh 
rate

See the tables below.

VGA - PC

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

1 800x600 60 7 1360x768 60 12 1600x1200 60

2 1024x768 60 8 1366x768 60 13 1680x1050 60

3
1280x720 

(analog default)
60 9 1400x1050 60 14 1920x1080 60

4 1280x768 60 10 1440x900 60 15 1920x1200 60

5 1280x800 60 11 1600x900 60 16 2048x1080 60

6 1280x1024 60

DVI - PC

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

17 800x600 60 23 1360x768 60 28 1600x1200 60

18 1024x768 60 24 1366x768 60 29 1680x1050 60

19 1280x720 60 25 1400x1050 60 30 1920x1080 60

20 1280x768 60 26 1440x900 60 31 1920x1200 60

21 1280x800 60 27 1600x900 60 32 2048x1080 60

22 1280x1024 60

HDMI - PC with 2-channel Audio

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

33 800x600 60 38 1360x768 60 43 1600x1200 60

34 1024x768 60 39 1366x768 60 44 1680x1050 60

35 1280x768 60 40 1400x1050 60 45 1920x1200 60

36 1280x800 60 41 1440x900 60 46 2048x1080 60

37 1280x1024 60 42 1600x900 60

HDMI HDTV

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

SIS 
Value

Resolution Refresh 
Rate (Hz)

47
480p 

2-ch audio
60 51

1080i 
2-ch audio

50 55
User assigned 
or imported 1

48
576p 

2-ch audio
50 52

1080i 
2-ch audio

60 56
User assigned 
or imported 2

49
720p 

2-ch audio
50 53

1080p 
2-ch audio

50 57
User assigned 
or imported 3

50
720p 

2-ch audio 
(digital default)

60 54
1080p 

2-ch audio
60

 

FOX T USW 103 Universal Switcher • Remote Control 14



Command and Response Tables for SIS Commands

Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Input Switching
Input selection

NOTE: The FOX T USW 103 saves the last input selection when cycling power.

Set video input selection X1!! InX1!•All] Select input X1!.

View video input selection ! X1!] View currently selected 
source.

Auto switch mode

Disable auto switch mode E0AUSW} Ausw0] Switch inputs manually 
(default).

Set priority to the highest 
active input

E1AUSW} Ausw1] Gives priority to the highest 
numbered active input.

Set priority to the lowest 
active input

E2AUSW} Ausw2] Gives priority to the lowest 
numbered active input.

View the auto switch mode EAUSW} X1@] View the auto switch mode.

Audio Configuration
Audio gain and attenuation

NOTE:   Gain and attenuation are case-sensitive.

Set gain X&G AudX(] Set gain to X(.

Set attenuation X*g AudX(] Set attenuation to X(.

Increment audio level +G or +g AudX(] Increase the gain or 
attenuation.

Decrement audio level -G or -g AudX(] Decrease the gain or 
attenuation.

View audio level G or g X(] View the audio level.

Input audio selection

Set audio input format EIX1!*X2%AFMT} AfmtIX1!*X2%] Set input X1! to X2% audio 
format.

View audio input format EIX1!AFMT} X2%] View the audio iput format.

NOTE: X& = Audio gain                                                   0 to 10 (0 = default) 
X* = Audio attenuation                                        –18 to 0 
X( = Audio level                                                   –18 to 10 
X1! = Input selection                                            1 = VGA (input 1) 
                                                                            2 = HDMI (input 2) 
                                                                            3 = HDMI (input 3) 
X1@ = Auto switch mode                                      0 = manual switching (default) 
                                                                            1 = priority given to the highest numbered active input 
                                                                            2 = priority given to the lowest numbered active input 
X2% = Audio input format                                     0 = auto (default) 
                                                                            1 = digital embedded 
                                                                            2 = analog
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Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Picture Adjustment (Analog Only)
Pixel phase

Set a pixel phase value E1*X2@PHAS} PhasX2@] Adjust the pixel phase to X2@.

Increment value E1+PHAS} PhasX2@] Increase the pixel phase.

Decrement value E1-PHAS} PhasX2@] Decrease the pixel phase

View pixel phase value E1PHAS} X2@] Show the pixel phase value

Total pixels

Set a value E1*X2#TPIX} TpixX2#] Set the total pixels.

Increment value E1+TPIX} TpixX2#] Increase the total pixels.

Decrement value E1-TPIX} TpixX2#] Decrease the total pixels.

View total pixel value E1TPIX} X2#] Show the total pixels.

Horizontal start

Set horizontal start value E1*X2$HSRT} HsrtX2$] Set horizontal location of first 
active pixel in active window.

Increment value E1+HSRT} HsrtX2$] Move the image to the right.

Decrement value E1-HSRT} HsrtX2$] Move the image to the left.

View horizontal start value E1HSRT} X2$] Show horizontal location of the 
first active pixel in active window.

EDID
NOTE:    Digital EDID can be assigned only to a digital input. Analog EDID can be assigned only to an analog 

input.

Input EDID (VGA and HDMI)

Assign factory EDID EAX1!*X2^EDID} EdidAX1!*X2^] Set the EDID resolution and 
refresh for input X1!.

View assigned EDID EAX1!EDID} X2^] View EDID resolution and refresh 
for input X1!.

View EDID native resolution ENX1!EDID} X@]
View current EDID in Hex ERX1!EDID} X#]
Export EDID selection EEX2^EDID} X$] Export EDID in binary format.

Import EDID to store 
location

EIX1$EDID}X$ EdidIX1$] Import EDID in binary format to 
user stored EDID slot X1$.

NOTE: X@ = Native resolution and refresh rate                 
X# = EDID record (Hex)                                         128 or 256 bytes 
X$ = EDID record (binary)                                     128 or 256 bytes 
X1! = Input selection                                            1 = VGA (input 1) 
                                                                            2 = HDMI (input 2) 
                                                                            3 = HDMI (input 3) 
X1$ = User assigned EDID                                     55 = VGA (input 1) 
                                                                            56 = HDMI (input 2) 
                                                                            57 = HDMI (input 3) 
X2@ = Pixel phase                                                0 to 63 (32 = default) 
X2# = Total pixels                                                 ±255 of the default value (depends on the input rate) 
X2$ = Horizontal start                                           0 to 255 (128 = default) 
X2^ = EDID output resolution                               See the tables on page 13.
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Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Advanced Configurations
Input sync detection

View input sync detection E1LS} xxx.x,xxx.x] Shows horizontal frequency in 
kHz and vertical frequency in 
Hz. Returns 000.0,000.0 if no 
signal is detected.

Input video format (VGA only)

Set input video format 1*X1%\ Typ1*X1%] Sets input 1 to format X1%.

View input video format 1\ X1%] View video format of input 1.

Front panel lockout

Set front panel executive 
mode

X%X ExeX%] Enable or disable (default) the 
front panel lockout (executive) 
mode.

View front panel executive 
mode

X X%] View the front panel lockout 
(executive) mode.

Plus mode transmission

Disable Plus mode 
transmission

81*0# Plus0] Disable Plus mode 
transmission.

Enable Plus mode 
transmission

81*1# Plus1] Enable Plus mode transmission 
(default).

View Plus mode transmission 81# X%] View Plus mode transmission 
setting.

HDCP authorized device (HDMI inputs only)

HDCP authorized device On EEX1!*1HDCP} HdcpEX1!*1] HDCP authorized device on for 
input X1! (default).

HDCP authorized device Off EEX1!*0HDCP} HdcpEX1!*0] HDCP authorization off for input 
X1!.

Query HDCP authorized 
device status

EEX1!HDCP} X^] View the HDCP authorization 
status.

HDCP status (HDMI inputs only)

Query HDCP status EIX1!HDCP} X1#] View the HDCP status.

NOTE: X% = Enable or disable                                         0 = off or not detected 
                                                                            1 = on or detected 
X^ = HDCP authorization                                     0 = HDCP authorization off 
                                                                            1 = HDCP authorization on (default) 
X1! = Input selection                                           1 = VGA (input 1) 
                                                                            2 = HDMI (input 2) 
                                                                            3 = HDMI (input 3) 
X1# = HDCP status (HDMI only)                           0 = no source device detected 
                                                                            1 = source detected with HDCP 
                                                                            2 = source detected but no HDCP is present 
X1% = Input video format                                      0 = auto detect (default) 
                                                                            1 = RGB 
                                                                            2 = YUV
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Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

Device name

NOTE:   No blank or space characters are permitted. The first character must be a letter. The last character 
cannot be a minus or hyphen.

Set unit name EX1^CN} Ipn•X1^] Set device name.

Set unit name to factory 
default

E•CN} Ipn•X1&] Set device to default.

View unit name ECN} X1^] View device name.

Information requests

Query general information I 1LnkX%•2LnkX%•VidX%•AudX%•X1)•TX]
Query firmware version Q x.xx]
Query firmware build *Q x.xx.xxxx]
Query part number N 60-1229-nn]
Query all firmware version 0Q x.xx-x.xx]
Query updated FPGA version 35Q x.xx]

Status request

View fiber link 1 status 1S X%]
View fiber link 2 status 2S X%]
View input video status 3S X%X%X%]
View input audio status 4S X%]
Request all signal status 5S SigIX%X%X%•SigO-•2HdcpIX%•3HdcpIX%•HdcpO-]
Request HDMI signal status 6S SigIX%X%•SigO-]
Request HDCP status 7S 2HdcpIX%•3HdcpIX%•HdcpO-]

NOTE: X% = On or off                                                       0 = off or not detected 
                                                                            1 = on or detected 
X1) = SFP module type                                       SM = singlemode 
                                                                            MM = multimode 
X1! = Input selection                                            1 = VGA (input 1) 
                                                                            2 = HDMI (input 2) 
                                                                            3 = HDMI (input 3) 
X1^ = Unit name                                                  text string up to 24 characters (A-Z, 0-9, -). No blank 
                                                                            or space characters are permitted. The first character  
                                                                            must be a letter. The last character cannot be a hyphen. 
X1& = Extron device name                                   FOX-T-USW-103
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Command ASCII Command 
(Host to Device)

Response 
(Device to Host)

Additional Description

View internal temperature

View internal temperature 20S X!] Internal temperature in 
degrees Fahrenheit and 
Celsius.

Factory reset

System Reset (factory default) EZXXX} Zpx] Resets unit to factory default.

Reset audio gain and 
attenuation

EZA} Zpa] Reset audio gain and 
attenuation to default levels.

Upload firmware

Upload firmware EUpload} Sendheader]
SFP module

View SFP module information 40S X1*•X1(•X2)•X2!]

NOTE: X! = Internal temperature                                    in degrees Fahrenheit and Celsius 
X1* = Vendor or manufacturer name 
X1( = Transmit (Tx) output power                         in dBm 
X2) = Receive (Rx) optical power                         in dBm 
X2! - Operation temperature                                in ˚C
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FOX Extenders 
Control Program

The Extron FOX Extenders Control Program provides an alternate method to control 
and configure the FOX T USW 103. The application provides controls to adjust device 
parameters that are specific to the basic and advanced setup of the transmitter. Users can 
also manage firmware and check for updates to the application. The Extron FOX Extenders 
Control Program communicates with the transmitter via the Remote RS-232 port on the rear 
panel Remote RS-232 and Alarm connector or front panel USB Config port. The program 
is compatible with Microsoft® Windows® 2000, Windows XP, or later Windows operating 
systems. Updates to this program can be downloaded from the Extron website  
(www.extron.com). Topics in this section include:

•	 Installing the Software

•	 Starting the Software

•	 Using the Software

Installing the Software
The program is contained on the Extron Software Products DVD or available for download 
on the Extron website, www.extron.com. 

To install the software from the DVD:

1. To install the software, insert the DVD into the DVD drive. The Extron software DVD 
window should appear automatically. If it does not self-start, run Launch.exe from the 
DVD. 

2. Click the Software tab, scroll to the desired program, and click Install. 

3. Follow the instructions that appear on the screen. By default, the installation creates a 
folder in the Program Files directory for the FOX Extenders Control Program.

To download the software from the website:

1. On the Extron website, click the Download tab.

2. From the left sidebar, click the Software link.

3. Navigate to FOX Extenders.

4. Click the Download link to the right of the desired device.

5. Submit any required information to start the download. Note where the file is saved.

6. Open the executable (.exe) file from the save location.

7. Follow the instructions that appear on the screen. By default, the installation creates a 
folder in the Program Files directory for the FOX Extenders Control Program.
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Starting the Software
Start the Extron FOX Extenders Control Program as follows:

1. Open the FOX Extenders Control Program. The Communication Setup window 
appears.

 

Figure 10. Communication Setup Window Connection Methods

2. Select the desired connection method.

•	 To connect the software to the device through the rear panel Remote RS-232 
connector, click the RS232 tab and select the desired port from the Port  
drop-down list.

•	 To connect the software to the device through the front panel USB connector, click 
the USB tab and select the Extron USB device from the Extron USB Device drop-
down list. 

3. Click the Connect button. The FOX Extenders Control Program window appears.

NOTE:  Some controls and displays are available only when connected to specific 
devices.

Using the Software
For more configuration and control details, see to the FOX Extenders Control Program Help 
File for configuration and control details. Open the file using one of the following methods:

•	 Once the FOX Extenders Control Program is open, press the <F1> key on the 
keyboard.

•	 Once the FOX Extenders Control Program is open, select Contents from the Help 
menu.

•	 From the Windows Start Menu, select FOX Extenders Help from the FOX Extenders 
Control Program folder.

The main screen opens (see figure 12 on page 23).

 

FOX T USW 103 Universal Switcher • FOX Extender Control Program 21



Figure 11. Main Screen

The main screen consists of a top menu, Status panel, Input Selection panel, and 
Configuration panel.

Top Menu
The top menu consists of three menus for connection options, device information and 
configuration, and additional resources.

File menu

The File menu contains options for connecting and disconnecting the device and exiting the 
FOX Extenders Control Program.

Figure 12. File Menu

Options that appear gray are not available.
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Connect

The Connect option establishes communication with a device. This function re-establishes 
communication with the device if it times out or enables a connection to a new device. 
If a device is already connected, the Connect function is disabled until the device is 
disconnected or the connection times out.

To re-establish the connection if communication is lost:

1. From the File menu, select Connect. Alternatively, click the  icon. This displays the 
Communication Setup dialog box, which is the communication module through which 
connection to the device is established. 

2. Select the communication port from the Port drop-down list. 

3. Click Connect. The Communication Setup dialog box closes and the FOX Extenders 
Control Program main screen remains open. 

Disconnect

The Disconnect option stops communication with the current device, but leaves the FOX 
Extenders Control Program open. Once disconnected, configuration can no longer be done 
unless connection is re-established.

To disconnect from the device, select Disconnect from the File menu or click the  icon. 
The status bar at the bottom of the window indicates that the device is disconnected.

Exit

The Exit option closes the FOX Extenders Control Program.

To exit the program, select Exit from the File menu.

Tools Menu

The Tools menu contains options for displaying device information or configuring the device.

Figure 13. Tools Menu
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Unit Info

The Unit Info option opens a dialog box with information about the connected device.

Figure 14. Unit Info Dialog Box

1. From the Tools menu, select Unit Info. This opens a dialog box displaying 
information about the connected unit. The displayed information includes:

•	 Model number of the device

•	 Name of the device model

•	 Description of the model

•	 Firmware version currently found on the device

•	 Firmware build

•	 FPGA version

2. Click the OK button to close the dialog box and return to the main screen. 

Reset Unit

There are three listed reset options:

•	 Master System Reset 

•	 Audio Gain/Atten. Reset 

•	 Presets Reset 

Depending on the chosen reset option, different settings are cleared.

Figure 15. Reset Unit Menu

NOTE:   Be careful to select the intended reset option. Selecting the incorrect reset can 
result in unintended loss of settings.
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Master System Reset — Resets all unit settings and user settings to factory defaults. 

From the Tools menu, locate the Reset submenu and select Master System Reset.

Figure 16. Unit System Dialog Box

Audio Gain/Atten. Reset — Resets the level of audio gain and attenuation to factory 
defaults.

From the Tools menu, locate the Reset submenu and select Audio Gain/Atten. Reset.

Figure 17. Audio Gain and Attenuation Reset Dialog Box

Presets Reset — Is not available for the FOX T USW 103.

Update Firmware

The Update Firmware option opens the Extron Firmware Loader application. This application 
is used to upload new firmware to the connected device.

NOTE:   In order for the Update Firmware option to work, install the Firmware Loader 
application (see Downloading Extron Firmware Loader on page 38). Otherwise, the 
Update Firmware option is disabled.

To update firmware:

1. From the Tools menu, select Update Firmware. Alternatively, click the  icon. This 
opens Firmware Loader (if this application is already installed on the connected PC). 

2. Find firmware to upload to the desired device by performing one of the following 
actions:

•	 From the File menu of Firmware Loader, select New Firmware for Selected 
Devices.

•	 In the Devices section of the Firmware Loader main screen, double-click the New 
Firmware File field associated with the selected device.

The Choose Firmware File dialog box opens.

3. Browse to the device-specific firmware file that has been downloaded on your PC. Valid 
firmware files have a BIN file extension (see Downloading Firmware on page 40).

4. Click the Open button. The Choose Firmware File dialog box closes.
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5. Click the Begin button. This uploads the new firmware onto the connected device. 
The Progress field for the selected device shows the progress of the upload. After the 
upload is complete, this field is blue and shows 100%. 

6. Exit Firmware Loader. 

7. From the File menu of the FOX Extenders Control Program, select Connect to  
re-establish communication with the device. 

8. Re-enter the connection information in the Connect dialog box to re-establish 
communication with the device. 

See the Firmware Loader Help File and supporting documentation for further information 
about using Firmware Loader.

Refresh

The Refresh option refreshes the main screen of the FOX Extenders Control Program 
without restarting the application. This is useful if connection to a device is lost (such as if 
the unit has been unplugged accidentally) or settings change on the device.

From the Tools menu, select Refresh. Alternatively, click the  icon.

Trace Window

The Trace Window option displays data sent to and received from the device in a separate 
window for troubleshooting.

Figure 18. Trace Window Dialog Box

1. From the Tools menu, select Trace Window. The Trace Window dialog box opens. 

2. To clear existing information, click the Clear button. 

3. Click the Close button to close the Trace Window dialog box. 
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Help Menu

The Help menu contains options for additional information and reference material, checking 
for updates to the FOX Extenders Control Program, and software information.

Figure 19. Help Menu

Contents

The Contents option launches the FOX Extenders Control Program help file.

Open the help file in one of the following ways:

•	 From the Help menu, select Contents.

•	 Press <F1> on your keyboard. 

•	 Click the  icon to launch the help file.

Extron Home Page

The Extron Home Page option displays the Extron website. The Extron website contains 
supporting documentation for Extron products and downloadable firmware and software 
updates (see Download Extron Firmware Loader on page 38).

From the Help menu, select Extron Home Page. This opens a new Internet browser 
window to the Extron website.

Check for Updates

The Check for Updates option verifies that the latest version of the FOX Extenders Control 
Program is being used. If there is a new version available, the option to install it becomes 
available.

From the Help menu, select Check for Updates.
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About...

This option opens a dialog box displaying information about the FOX Extenders Control 
Program.

1. From the Help menu, select About. This opens a dialog box displaying information 
about the FOX Extenders Control Program. The displayed information includes:

•	 Name of the application

•	 Currently installed software version

•	 Software part number

•	 Copyright

•	 Application description

Figure 20. About FOX Extenders Control Program Dialog Box

2. Click the OK button to close this dialog box and return to the main screen of the 
application. 
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Main Screen
The Main Screen contains status information, input selection, and configuration options.

Figure 21. Main Screen

NOTE:   The main screen may appear different from the image above depending on what 
is connected. Functions which are not applicable are disabled.

Status panel

Figure 22. Status Panel

The Status panel of the screen provides visual indications of the connection status and the 
names of the connected units. The following information is displayed:

Link 1 Indicator — Displays green when the receiver detects light on Link 1 (connecting 
the Tx port of the transmitter to the Rx port of the receiver).

Link 2 Indicator — Displays green when an HDMI transmitter detects light on Link 2 
(connecting the Tx port of an HDMI receiver to the Rx port of an HDMI transmitter). 

NOTE:   For transmission of HDMI video with HDCP content, two fibers are required.
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Video Indicator — Displays green when the transmitter detects an active signal on the VGA 
input. 

Audio Indicator — Displays green when the device detects audio with the selected input. 
If the selected input has an analog audio signal above -44 dBV, the indicator turns green 
immediately, but turns gray after the audio signal level drops below the threshold continuously 
for 10 seconds. If the selected input has digital embedded audio, the indicator displays green 
and remains green as long as the digital audio signal is detected.

HDMI Indicator — Displays green when the unit receives an HDMI input signal. 

HDCP Indicator — Displays green if the input signal is HDCP-encrypted. 

EDID Minder — Displays the current EDID Minder settings. 

Input Frequency — Displays the horizontal and vertical frequencies of the current input. This 
field indicates No Input Signal if there is no input signal. 

Model — Displays the model of the device that is connected via RS-232 or USB. 

Connected to — Displays the communication port of the unit that is connected to the PC. 
This can be either a communication port on the transmitter or a communication port on the 
receiver. 

Other side — Displays N/A whenever connected to a FOX T USW 103.

Temperature — Displays the internal temperature of the device. 

Input Selection panel

The Input Selection panel is used to select inputs manually or automatically.

Figure 23. Input Selection Panel

Select Input — Select the desired input. The currently selected input is green. The left button 
represents Input 1 (VGA). The right button represents Input 2 (HDMI). 

Auto Switch Mode — Allows the device to auto switch inputs based on the chosen 
configuration. The options are Disabled, Priority to Highest Active, or Priority to Lowest Active.

NOTE:   The Default setting on the FOX T USW 103 is Disabled.

Control tab

The Control tab contains picture and audio adjustments. To access these options, click the 
Control tab.

Figure 24. Control Tab
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VGA Video Adjustment panel

The VGA Video Adjustment panel of the Control tab adjusts the following video parameters 
on the analog input: horizontal start, pixel phase, and total pixels.

Figure 25. VGA Video Adjustment Panel

Horizontal Start — Defines the number of pixels in the blanking area to the left of the 
active area.

In the Horizontal Start panel of the VGA Video Adjustment panel, click the Left or Right 
arrows, or click and drag the slider to adjust the setting to the desired value. The field to the 
right of a slider shows the current value for the associated setting.

NOTE:   The value for Horizontal Start can range between 0 and 255.  
Default setting: 128.

Pixel Phase — Controls the pixel phase. Sampling at the optimum pixel phase results in a 
bright, stable output.

In the Pixel Phase panel of the VGA Video Adjustment panel, click the Left or Right 
arrows, or click and drag the slider to adjust the setting to the desired value. The field to the 
right of a slider shows the current value for the associated setting.

NOTE:   The value for Pixel Phase can range between 0 and 63. Default setting: 32.

The Total Pixels setting (see below) must be correctly set before adjusting Pixel Phase.

Total Pixels — Controls the total number of pixels in an active window.

In the Shift panel of the VGA Video Adjustment panel, click the Left or Right arrows, or 
click and drag the slider to adjust the setting to the desired value. The field to the right of a 
slider shows the current value for the associated setting.

NOTE:   The Total Pixels setting depends on the input rate. It is ±255 of the default value.
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Audio Adjustment panel

The Audio Adjustment panel of the Control tab allows adjusts the gain and attenuation of 
analog input audio.

Audio Gain and Attenuation — Adjusts the analog input audio gain or attenuation value. 
This ranges from -18.0 dB to +10.0 dB in 1.0 dB increments.

In the Audio Gain/Atten. panel, click and drag the slider to the desired level. The current 
value is displayed in a field below the slider control.

Audio Output Level — Is not available for the FOX T USW 103.

I/O Configuration Tab

The I/O Configuration tab contains options for input and output settings. To access these 
options, click the I/O Configuration tab.

Figure 26. I/O Configuration Tab

HDCP panel

The HDCP Authorized setting allows a user to turn off HDCP communication on discrete 
inputs. This setting is useful for devices such as Mac computers, iPhones, iPads, and some 
Windows 7 sources that will always encrypt their output if the downstream sink is capable 
of HDCP. By not allowing HDCP signals on an input, most content from these sources can 
be passed as a non-encrypted signal to analog and digital video outputs. In a video system 
that has requirements to not transmit HDCP encrypted data (such as non-HDMI FOX 
Extenders), HDCP Authorized should be turned off at the input to keep the non-HDMI FOX 
Extender’s output unencrypted. 

In the HDCP panel, select the On radio button to enable the HDCP Authorized setting or 
select Off to disable the HDCP Authorized setting.

NOTE:   Default setting: HDCP Authorized is On.
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Plus Mode Transmission panel

Plus mode can support rates up to 1920x1200 @ 60Hz, with embedded audio, and is 
HDCP compliant. Non-Plus mode supports rates up to 1600x1200 and 1080p, is HDCP 
compliant, and does not contain embedded audio (analog audio is still supported).

In the Plus Mode Transmission panel, click the Enabled radio button to enable Plus mode. 
To disable Plus mode, click the Disabled radio button. 

NOTE:   Default setting: Plus Mode is Enabled.

VGA Input Video Format panel

This setting selects RGB or YUV Input Video Format for the VGA input. 

NOTE:   Default setting: VGA Input Video Format is Auto.

Audio Input Selection panel

This panel sets the audio type for the VGA and HDMI inputs, or set them to Auto for 
automatic selection.

For each input, select the desired audio input type from the Input drop-down list.

Figure 27. Audio Input 1 Options

NOTE:   Default setting: Audio Input Selection is Auto for all inputs.

Advanced Tab

Figure 28. Advanced Tab
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Advanced Configuration panel

Executive mode restricts access to the front panel button functions.

To enable or disable executive mode,  click either the On or Off radio button in the Executive 
Mode panel.

NOTE:   Turning on Executive Mode will not disable the ability to control the device with 
the FOX Extenders Control Program.

EDID Configuration Tab

EDID is a data structure used to communicate video display information, including native 
resolution and vertical refresh rate requirements, to a source device. The source device then 
outputs the optimal video format for the display based on the provided EDID data, ensuring 
proper video image quality.

To access EDID options, click the EDID Configuration tab.

Figure 29. EDID Configuration Tab

Assigned EDID panel

This shows the current EDID configuration for each input. You can assign unique EDID for 
any input.

Figure 30. Assigned EDID Panel

Choose the desired EDID from the drop-down list of the desired input. 

NOTE:   The default EDID is 720p for HDMI inputs and 1280x720 for VGA input.

Save EDID panel

NOTE:   This setting is not available for the FOX T USW 103.
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Import EDID panel

EDID files can be imported to the FOX T USW 103 and saved in a table on the device.

NOTE:   When an EDID file is imported to a user assigned input location, the EDID is 
automatically assigned to the selected user input.

Figure 31. Import EDID Panel

1. In the Import EDID panel, from the drop-down list, select the desired input.

Figure 32. Import EDID Options

2. Click on the Browse button to locate and select the desired EDID file on the connected 
PC. The Open dialog box opens.

Figure 33. Browse Button for Importing EDID

3. Select the EDID file and click the Open button. The Open dialog box closes.

4. Click the Import button. The EDID is imported and assigned to the selected input. 
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Export EDID panel

EDID files on the FOX T USW 103 can be exported to the connected PC. To open and view 
them, use the Extron EDID Manager software, available at www.extron.com.

The EDID Manager software aids in troubleshooting any EDID related issues that may occur 
during configuration or operation of an AV system.

Figure 34. Export EDID Panel

1. In the Export EDID panel, select the desired EDID to export from the drop-down list. 

2. Click the Export button. The Save As dialog box opens.

3. Select the export destination and file name for the EDID. 

4. Click the Save button. The EDID setting is exported. 

 

FOX T USW 103 Universal Switcher • FOX Extender Control Program 36

http://www.extron.com


Reference 
Information

This section provides mounting and firmware updating information. Topics in this section 
include:

•	 Mounting

•	 Updating Firmware

Mounting
The FOX T USW 103 can be placed on a tabletop or mounted in a rack or underneath a desk.

Tabletop Use
Attach the provided rubber feet to the bottom four corners of the enclosure.

Mounting Kits
Mount the unit using any optional compatible mounting kit listed on the Extron website  
(www.extron.com), in accordance with the directions included with the kit. For  
rack-mounting, see UL guidelines for rack-mounted devices below.

UL guidelines for rack-mounted devices

The following Underwriters Laboratories (UL) guidelines pertain to the safe installation of the 
FOX T USW 103 in a rack.

1. Elevated operating ambient temperature — If installed in a closed or multi-unit rack 
assembly, the operating ambient temperature of the rack environment may be greater 
than room ambient temperature. Therefore, install the FOX T USW 103 in an environment 
compatible with the maximum ambient temperature  
(Tma = +122 ˚F, +50 ˚C) specified by Extron.

2. Reduced air flow — Install the equipment in a rack so that the amount of air flow 
required for safe operation of the equipment is no compromised.

3. Mechanical loading — Mount the equipment in the rack so that a hazardous condition 
is not achieved due to uneven mechanical loading.

4. Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have an overcurrent protection and supply wiring. 
Appropriate consideration of equipment nameplate ratings should be used when 
addressing this concern.

5. Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct connections 
to the branch circuit (e.g. use of power strips).
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Updating Firmware
To update firmware for the FOX T USW 103, download the new firmware to a connected 
computer and upload the firmware with the Firmware Loader utility or the  
FOX Extenders Control Program (see to the FOX Extenders Control Program Help File).

Downloading Extron Firmware Loader

Figure 35. Firmware Loader on the Extron Website

1. On the Extron website, www.extron.com, click the Download tab.

2. From the left sidebar, click the Software link.

3. Navigate to Firmware Loader.

4. Click the Download link on the right that corresponds with the program.

5. Submit any required information to start the download.

Installing Firmware Loader
1. Once Firmware Loader has been downloaded, run the .exe file from the save location. 

The installation wizard window opens.

2. Click Next to continue through the process, filling out necessary information and 
specifying custom settings on each prompt.
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Downloading Firmware

Figure 36. Downloading Firmware from the Extron Website

1. On the Extron website, www.extron.com, click the Download tab.

2. From the left sidebar, click the Firmware link.

3. Navigate to FOX T USW 103.

4. Ensure the available firmware version is a later version than the current one on the 
device.

NOTE: The firmware release notes are in a PDF file that provides details about the 
changes between different firmware versions. The file can be downloaded from the 
same page as the firmware on the Extron website, www.extron.com.

5. Click the Download link to the right of the desired device.

6. Submit any required information to start the download. Note where the file is saved.

7. Open the executable (.exe) file.

8. Follow the instructions on the Installation Wizard screens to install the new firmware on 
the computer. A Release Notes file, giving information on what has changed in the new 
firmware version, and a set of instructions for updating the firmware are also loaded.
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Installing Firmware with Firmware Loader
1. Open Firmware Loader to establish a connection between the computer and the device. 

The Add Device... dialog box opens.

Figure 37. Add Device... Window

2. Select FOX T USW 103 from the Device Name drop-down list.

3. Select the method of connection from the Connection Method drop-down list.

4. Depending on the connection method, additional options appear. Make the appropriate 
selections for the current connection method.

5. Click Connect.

6. Click Browse in the New File Firmware (Optional) section.

7. On the Open window, navigate to the new firmware file, which has an .S19 extension, 
and click Open.

ATTENTION: Valid firmware files must have the file extension .S19. A file with 
any other extension is not a firmware upgrade for this device and could cause the 
device to stop functioning.

8. Click Add. The Add Device... window closes and the device and firmware are listed in 
the Firmware Loader main window.

9. Click Begin to start the upload process.

10. Close Firmware Loader when the Remaining Time field shows 00.00.00, the 
Progress column shows 100%, and the Status field shows completed (see Factory 
Reset SIS commands on page 19 for reset information).
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Extron Headquarters
+1.800.633.9876 (Inside USA/Canada Only)

Extron USA - West Extron USA - East 
+1.714.491.1500 +1.919.850.1000 
+1.714.491.1517 FAX +1.919.850.1001 FAX

Extron Europe
+800.3987.6673 
(Inside Europe Only)

+31.33.453.4040 
+31.33.453.4050 FAX

Extron Asia
+65.6383.4400
+65.6383.4664 FAX

Extron Japan
+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China
+86.21.3760.1568 
+86.21.3760.1566 FAX

Extron Middle East
+971.4.299.1800
+971.4.299.1880 FAX

Extron Korea
+82.2.3444.1571
+82.2.3444.1575 FAX

Extron India
1800.3070.3777 
Inside India Only

+91.80.3055.3777 
+91.80.3055.3737 FAX

© 2013 Extron Electronics   All rights reserved.   www.extron.com

Contact Information

Extron Warranty

Extron Electronics warrants this product against defects in materials and workmanship for a period of three years 
from the date of purchase. In the event of malfunction during the warranty period attributable directly to faulty 
workmanship and/or materials, Extron Electronics will, at its option, repair or replace said products or components, 
to whatever extent it shall deem necessary to restore said product to proper operating condition, provided that it is 
returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron Electronics 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

 
Japan: 
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe and Africa: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia: 
Extron Asia Pte Ltd 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE: If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process. 
 
USA: 714.491.1500 or 800.633.9876 Europe: 31.33.453.4040  
Asia: 65.6383.4400 Japan: 81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron Electronics be liable for direct, 
indirect, or consequential damages resulting from any defect in this product even if Extron Electronics has been 
advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.

http://www,extron.com
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